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Logging Into Your Website for the First Time

Open Internet Explorer (you may have done this already).

Go to the Villanova Homepage (www.villanova.edu).

Log into the homepage (you may need to click the Log Off button at the top right corner of the page first).
Your login username and passwords are the same as your email username and password.

To edit your website, click the the Edit with Microsoft FrontPage icon on the Internet Explorer toolbar (see below). If
you don’t see the FrontPage icon on the toolbar, you will need to click the down arrow to the left of the word
Discuss and then select Edit with FrontPage.

® .. o 3

Edit Discuss  Research  Messenger

|Edit with Microsoft Office FrontPage |

When prompted, enter your Villanova user name and password (same as e-mail). If you want FrontPage to
remember your user name and password, check the box telling it to do so.

If you typed your user name and password in correctly, your website should open up and you will be brought
directly to your index.html file, which is your homepage. This is the page that people will see when visiting your
website.

To register for a free Introduction to FrontPage workshop, visit the UNIT Workshops website at
http://unit.villanova.edu/workshops. Look for the Editing Your Personal Website course. You can register online at
that site by clicking the Workshop Registration link.

If you have any problems logging into your website, contact the Helpdesk at 610-519-7777 (x97777).



LESSON 1 -
WORKING WITH YOUR WEBSITE

GETTING STARTED

Discussion
If you logged into your website using the directions on the previous page, once you are logged in, you will
notice that your index.html file is open on your screen. The index.html file is your homepage.

To start working on your new homepage, you can delete any text that may be on the page and begin typing
the information that you want to appear on your homepage (name, contact information, etc.).

This manual will help you to insert text, format the page background, create new web pages, insert hyperlinks
and pictures, and create tables in your web pages.

WORKING WITH FRONTPAGE

Discussion
FrontPage has two main views that you will use to edit your website:

1. The Web Site view allows you to view all the files and folders on your website.

2. The Page view is the view that you are in when you have a web page (such as your index.html) open.

Itis in the Page view that you will do your editing. Two main views in FrontPage:
Web Site View and Page View

The Web Site view is also known as the Folders view, which is why when you
are in the Web Site view, you will see the word Folders highlighted at the bottom of the screen in the Views

pane — see below. When you are in the Web Site view, you will notice a few other viewore information about

these views (which you may never need), click the &) button on the FrontPage toolbar and type “About
Views” in the Search for: box.

EiFolders | @ Remote Web site BIReports doMavigation B Hyperlinks B Tasks

When you begin editing your website for the first time, if you click on the Web Site button at the top left side of
the window, you will see the following screen:

! Fle Edit View Insert Format Tools Table Data Frames Window Help
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Contents of 'C:\Documents and Settings\support\My Documents'My Web Sitesmysite’
Size  Type Madified Date Modified By Comments

Name: Title

&) _private

ID)images
findex. hml index.html 1B himl

5/2/2005 4:157M VUAD yschalle

You should see the following:

1. _private folder — a secure folder — you may never use this, but do not delete it
2. images folder — this is where you will store any pictures that you insert into your webpages

3. index.html file — this is your homepage



LESSON 2 -
WORKING WITH PAGE VIEW

USING PAGE VIEW

Discussion

Page view is where you will spend most of your time in FrontPage, as it allows you to create and edit the
content of a web site. You can use Page view to work with text, graphics, colors, and backgrounds, as well as
other properties of a web that ultimately control its content.

When you are editing a page on your website, you will see four tabs at the bottom left-side of the screen:

Design — this is the view in which you will enter and edit the content of your web

Code - this view displays the HTML code for each web page

Split — this view displays a split screen, with Code view on top and Design view on bottom
Preview — this view allows you to preview your web site to see how it will appear on the web

el

While working in Design view, if you want to flip back to your folder list, you can do one of two things:

1. Click the Web Site button to switch over to the folders view OR
2. Turn your Folder List on by clicking View and selecting Folder List. This will display your folder list at
all times, regardless of which view you are in.

SWITCHING BETWEEN OPEN WEB PAGES

Discussion

As you edit web pages in Page view, you will find that it is often convenient to work with multiple pages open
simultaneously. You can copy, move, and compare information between open pages. To move between open
pages, you can use both the Folder List and the page tabs at the top of the view pane. While you can use the
same method to open or switch between pages using the Folder List, page tabs only appear in the view pane
for open web pages. Switching between pages using
the page tabs is a quick method of moving to pages
and a good option to use when the Folder List is
hidden.

S| | = (1< I 0 e TS =T W [ ol PR = e - (|

[l Web Site || july0s.html june05.html

Click a page’s tab to switch from
one open webpage to another

You can also switch between open pages using the Window menu.

If you want to open a particular web site in multiple FrontPage windows, select the
Window menu and then select the New Window command.




ADDING, EDITING, AND DELETING TEXT

Discussion

An important aspect of a good web site is its textual content. A successful web will convey information to its
visitors, most often through words and images. You can add, edit, and delete text as desired in Page view.
When working with text, you can use the FrontPage formatting features in much the same way that you would
use an ordinary word processor or text editor. If you have worked with formatting in other Microsoft Office
applications, you will find that FrontPage functions similarly.

A wavy red line may appear below the text if the word is misspelled, or correctly spelled
but not in the FrontPage dictionary.

You can delete an object the same way you delete text, by selecting the object and
pressing the [Delete] key.

Procedures

Open the page in which you want to add, edit, or delete text in Page view.
To add text, position the insertion point where you want the text to appeatr.
Type the desired text.

To edit text, select the text you want to edit.

Edit the text as desired.

To delete text, select the text you want to delete.

S L R A

Press [Delete].

SAVING AN EXISTING WEB PAGE

Discussion

As you modify web pages in Page view, you will need to save them. Whether you are working in a web that
was created by a wizard, or you are working with an existing web that has already been named or saved,
saving your web page is a simple process. When you begin creating new web pages, saving a page will
require that you name it and define certain properties.

When you are saving a web page in which pictures or other objects, such as sound or video clips, have been

embedded, you are prompted to save embedded files to the web. Saving the embedded files to the web allows
the files to be published along with the web pages, making them accessible to site visitors.

Procedures

1. Open the desired page in Page view.

2. To save an existing web page with the same name, click the Save button on the

Standard toolbar.




3. If you are prompted to save embedded files to the web, select OK.

PREVIEWING A WEB PAGE

Discussion

Page view has a Preview page that enables you to see how the current page will look when a user is
browsing the Internet. Viewing this page is a quick and easy way to check your page as you develop it. The
Preview page allows you to test and preview different designs, text, pictures, video clips, and hyperlinks.

The Preview page gives you a fairly close representation of what a page will look like in a browser. If your
page is still in development, however, certain elements may not appear correctly. A message to this effect
appears at the top of the Preview page if this is the case. For the most accurate representation of the page,

you should view it in a browser.

the browser window.

In order for the Preview page to appear, you need Microsoft Internet Explorer installed on
your system. If the Preview page is not available, save the current page and then click the
Preview in Browser button on the Standard toolbar. You can then preview the page in

Procedures
1. Open the desired page in Page view.

2. Click the Preview tab.

PREVIEWING A WEB IN A BROWSER

Discussion

The way your web pages appear in Page view, even on the Preview page, is not exactly the way
they will appear in a web browser when a site visitor accesses your web. For this reason, %

you should preview your web pages in a browser to make sure that your design elements /

look clear and work well in the browser. In addition, some page elements, such
as hover buttons and banner ads, cannot be viewed on the Preview page; you
must preview them in a browser. If the Preview page is not available to you,
you can only preview your pages in a web browser. It is particularly important
that you preview your web site in a browser before publishing it.

Click “Preview in Internet Explorer”

on the toolbar to view your page on
the weh

You can quickly preview a web page in a browser using the Preview in Internet Explorer button on the
Standard toolbar. This will open your webpage in Internet Explorer. Be sure to save your web page before
using this button. If the current page is not saved, you will be prompted to save the page before you can

preview it.

Note: If you are going back and forth between the web and your webpage in FrontPage, be sure to save your
changes in FrontPage, then hit the Refresh button in Internet Explorer to see your most recent changes.




LESSON 3 -
CREATING WEBS

ADDING CONTENT TO A HOME PAGE

Discussion

The home page is the main page of a web site. Typically, it is the first page that appears in a user’s browser
when he or she visits a web; therefore, the home page is a good page to start building content for a web site.

In order for the home page to open automatically on the World Wide Web, most servers require that the file be
named index.htm or default.htm. If your are running a local web server, the home page is default.htm. If you
are not running a local web server or are storing the new web on your hard drive, the home page is
index.htm.

When you open the home page, it opens in Page view on the Normal page. You can then add text and other
objects to the page, format them, and move or copy them as desired. When you create the content for your
home page, keep in mind that this page is the first thing someone sees when your web site opens. So,
remember, you get only one chance to make a good first impression.

Procedures
1. Create a new web or open an existing web.
2. Display the Folder List.
3. Double-click index.htm or default.htm in the Folder List to open the home page.
4. Add the desired text to the home page.
5. Press [Enter] to move the insertion point to the next line and begin a new paragraph.
6. Continue adding text and objects as desired.
7. Save the web page.

ADDING PAGES TO A WEB

Discussion

As you build a web, you will need to add new web pages. These new pages will contain information that will be
accessible from links on the home page or other pages. For example, if you plan on creating an About Me link
on your home page, you will need a page containing the information to which the text About Me will link.

You can create a new page using the New Page or Web task pane or the Create a new normal =
page button on the Standard toolbar. Using either tool, you can quickly create a new, / i -

blank web page or open the Page Templates dialog box. The Page Templates dialog

box contains a variety of FrontPage templates to help you create new

pages in your web site Click “Create a new normal page”

on the Standard Toolbar to create
a blank webpage

When you create a new page, it appears on the Normal page in Page

view. The default page name, such as new_page_1.htm, appears on the page tab. After you add a page, you
must save it in order for it to appear in the Folder List (see below for tips on saving web pages).



The New Page or Web task pane contains a New from existing page section. You can
click the Choose page link in this section to select a page on which you want to base a
new page. This feature is helpful when you want to create a page similar to an existing
page, but with some modifications.

SAVING A NEw WEB PAGE

Discussion

As you create pages, it is a good idea to save them. If you do not save a page before you try to close the web
or preview it in a browser, you will be prompted to save it. In addition, until you save a page, it will not appear
in the Folder List.

When you save a page for the first time, you can change the title of the page. The page title appears in the
browser title bar when a page is opened. The title should represent the content and purpose of the page. If you
do not create the page title when you save a new page, you should make sure that you do so before finalizing
your web. You may use capital letters and spaces in the page title, but not in the file name.

The file name is created separately and should be different from the page title. The file name should represent
the page content so that you can use the Folder List or page tabs to quickly and easily navigate the pages in
your web.

File names should be all lowercase with no spaces. If you need a space in a file name, use an underscore ();
e.g., a good filename for your About Me file would be about_me.htm.

You can change the title of a page by right-clicking an area on the page, selecting the Page
Properties command, entering the desired title in the Title text box on the General page,
and then selecting OK to save the changes.

Procedures

1. Create a new web or open an existing web.

2. Create a new page.

4. Type the desired file name for the page in the File name text box,
remembering not to use capital letters or spaces in the file name.

3. Click the Save button on the Standard toolbar.

5. Select Change title to change the page title.

6. Type the new page title in the Page title text box. You may use caps
and spaces in the page title.

7. Select OK.

8. Select Save.

10



INSERTING A FILE INTO A WEB PAGE

Discussion

You can insert most types of text-based files, such as .txt, .rtf, .asp, and .htm, as well as Microsoft Office
documents, into a web page in Page view. This feature allows you to incorporate existing files, such as
Microsoft Word files, into a web page and quickly generate content for a web. You can insert files to add to the
content of an existing page or to replace existing text, such as template text. FrontPage automatically converts
the file into HTML if it is not already in this format.

The first time you insert a file, you may be prompted to install a converter in order for the
file to be displayed correctly. You can then select Yes to start the installation process. You
should have the FrontPage CD-ROM available as you may need it to complete the
installation.

Procedures

1. Open your website.

2. Create a new page or open the page into which you want to insert the file.

w

Position the insertion point in the desired location or select the text you want to replace with the
file text.

Select the Insert menu.

Select the File command.

Select the Look in list.

Select the drive containing the file you want to insert.

Select the folder containing the file you want to insert.

© © N o 0o &

Select the Files of type list.

10. Select the file type of the file you want to insert or select All Files to display all files in the
selected folder.

11. Select the file you want to insert.

12. Select Open.

IMPORTING A FILE INTO A WEB

Discussion

You can import existing web pages and other files into your web. You can import HTML, image, and Office
files from another web site or another location to which you have access. By importing existing files into a web,
you can reduce development time by using existing content. The files you import can contain hyperlinks to
other web sites, which are preserved during the import process.

You can use the Import dialog box to locate the files that you want to include in your web. You can add and

remove items from this dialog box as desired. To import a file into a web site, it first must be present in the
Import dialog box.

11



After the files are imported, they appear on the Folder List. If you attempt to open the file as you would a page,
the file opens, but in the application in which it was created, if available. In order to use an imported file as a
web page, you need to open it using FrontPage. When you open a file using FrontPage, the file content is
inserted into a new web page and the original file remains in the Folder List. You can then save the new web
page with the desired name and page title.

You can also use the Import dialog box to import a folder or web site. Like importing a file, importing a folder or
web site can help reduce development time.

You can select multiple files in the Add File to Import List dialog box by holding the [Ctrl] key
and clicking the desired files. If the files are listed consecutively, click the first file, hold the
[Shift] key, and then select the last file in the range.

If a FrontPage web is not open, selecting the File menu and then selecting the Import
command starts the Import Web Wizard, which allows you to import an entire web to create a
new web site. This new site can be stored on your hard drive or other location to which you
have access.

To open a file in the application in which it was created, double-click the file in the Folder List
or right-click the file and then select the Open command.

Procedures
1. Open your website and click the Web Site button. Click the folder where you want to import
your file(s).
2. Select the File menu.
3. Select the Import command.
4. Select Add File.
5. Select the Look in list.
6. Select the drive containing the file you want to import.
7. Select the folder containing the file you want to import.
8. Select the Files of type list.
9. Select the type of file you want to import or select All Files to view all files in the folder.
10. Select the file you want to import.
11. Select Open.
12. Select OK.
13. Right-click the imported file.
14. Select the Open With command.
15. Select the editor you want to use to open the file in the Editor list box.
16. Select OK.

12



DELETING A WEB PAGE

Discussion

You can delete pages and files from a web site that you no longer need or maintain. Deleting a file from a web
only deletes it from the folder in which it is stored, and only that location. If the file exists in other locations
(such as another folder on your hard drive), it remains there until it is deleted.

| You can delete a page or file by selecting the object and pressing the [Delete] key. |

Procedures

Open your website.

Display the folder list by clicking the Web Site tab.

Right-click the page or file in the Folder List that you want to delete.

Select the Delete command.

o r w N e

Select Yes.

13



LESSON 4 -
FORMATTING AND ENHANCING WEB PAGES

ALIGNING TEXT IN A WEB PAGE

Discussion

Text alignment is an important consideration when developing web pages. Using center, left, or right
alignment, you can control the layout of text in a web. You can also fully justify the text on your page, in which
case the text is aligned evenly along the left and right margins.

Text alignment affects an entire paragraph. If you want to align a single paragraph, you do not need to select
the text; you only need to position the insertion point in the paragraph. If you want to align more than one
paragraph at the same time, you must select all of the paragraphs to be aligned.

You can also change the position of the text on a page by right-clicking the desired text
and then selecting the Paragraph command. In the Paragraph dialog box, you can
change the text alignment, indentation, and spacing.

When you select multiple paragraphs, be sure to include the paragraph marks (). You can
use the Show All button on the Standard toolbar to display the paragraph marks and
other nonprinting characters.

Procedures
1. Open or switch to the page containing the text you want to align.
2. Select the text that you want to align.

3. Click the desired alignment button on the Formatting toolbar.

CHANGING THE APPEARANCE OF A FONT

Discussion

You can change the appearance of text in a web page by formatting fonts and changing font types. Font
formatting in FrontPage works just as it does in other Microsoft Office applications.

The Font dialog box allows you to change the type of font, as well as apply formatting attributes such as bold,
italic, and underline. You can also change the font size and color. Each time you make a selection in the Font
dialog box, the Preview box changes to reflect your choices, enabling you to see how your text will be
formatted before you apply the changes.

While the Font dialog box provides a central location to apply multiple font attributes, you can quickly apply

individual attributes such as bold, italic, underline, font type, font size, and font color using the appropriate
buttons and lists on the Formatting toolbar.

14



Procedures

1.

© N o gk~ 0w DN

Open or switch to the page containing the text you want to format.

Select the text with the font you want to change.
Select the Format menu.

Select the Font command.

Select the desired font from the Font list box.

Select the desired style from the Font style list box.
Continue to select font formatting options as desired.
Select OK.

INSERTING A HORIZONTAL LINE

Discussion

You can create sections within a web page using horizontal lines. Lines help to organize elements of a web
page and can enhance the appearance and readability of a document.

If you apply a theme to a web, the horizontal line will change to coordinate with the selected
theme.

Once you insert a horizontal line, you can change its width, height, alignment, and color in
the Horizontal Line Properties dialog box. To open the Horizontal Line Properties dialog
box, double-click the horizontal line.

Procedures
1. Open or switch to the page on which you want to insert the horizontal line.
2. Click in the web page where you want the line to appear.
3. Select the Insert menu.
4. Select the Horizontal Line command.

ADDING A BACKGROUND COLOR TO A WEB PAGE

Discussion

You can enhance a web page by changing the background. Background colors or pictures add an element of
interest to a web page and can be used to capture a site visitor’s attention.

You can add a background picture from several sources: a site on the Internet, a folder on your local
computer, or a clip art image. You should be aware that adding a background picture requires transferring a
picture file when the page loads. This process increases the transfer time from the server to the web browser.

Background colors do not require the transfer of a separate file. A web page using a background color rather
than a background picture will transfer faster and will make the page more appealing from a performance
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perspective. If you add both a background picture and a background color, the picture is placed “on top” of the
color and may block the color out.

To use a background picture for a web page, select the Background picture option on the
Background page in the Page Properties dialog box. Then, type the picture file location or
use the Browse button to locate the file. If you select the Watermark option, the
background picture remains in a fixed position and does not scroll as site visitors move
around a page.

You can also use a background sound for a page. To insert a background sound, select the
appropriate sound file using the options on the General page in the Page Properties dialog
box. You can set the background sound to play a set number of times or leave the default
of forever, in which case the sound plays the entire time the page is displayed.

You can change the colors of other elements in a web page, including text and hyperlinks.
Depending on the background color you select, you may need to change the color of these
other elements. For example, the default black text color will not be readable with a dark
blue or black background color.

Procedures

Open or switch to the page to which you want to add a background color.
Right-click any area of the page.

Select the Page Properties command.

Select the Background tab.

Select the Background list below Colors.

Select the desired color.
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Select OK.
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LESSON 5 -
WORKING WITH LINKS

WORKING WITH HYPERLINKS

Discussion

You can create hyperlinks in FrontPage to organize your web and enable site visitors to more easily navigate
it. Hyperlinks can be in the form of text or pictures. When a hyperlink is clicked, some sort of corresponding
action occurs. For example, if the text Home is a hyperlink, clicking it brings a site visitor back to the home
page of the web site. Clicking a hyperlinked picture of a company’s product could open a page containing
product information.

Typically, hyperlinked text is underlined and in a color different from the rest of the web page, enabling site
visitors to easily identify the link. If the text is not in this format or the hyperlink is a picture, site visitors can
identify a potential link on a web page as the mouse pointer changes into a hand when resting on it.

To create a hyperlink, you need to select the text or picture to be used as the link and then open the Insert
Hyperlink dialog box. The options on the left side of this dialog box, below Link to:, enable you to choose the
location where the linked information is stored. You can choose the Existing File or Web Page option to
search for a file in the current web or another location, as well as enter the URL for a web site or select a
recently browsed page. You can select the Place in This Document option to link to a specific location within
the page to which you are linking. You can choose the Create New Document option to link to a new web
page and then edit it at the time of creation or later. You can select the E-mail Address option to create a link
to an e-mail address.

By default, hyperlinked text is blue and underlined in FrontPage. However, if a theme or
style sheet is applied to the web, the linked text appears in the color specified by the theme
or style sheet.

LINKING TO AN EXISTING FILE OR WEB PAGE

Discussion

You can create a hyperlink to an existing file or page in the current web or in another location. When you open
the Insert Hyperlink dialog box, you can choose the Existing File or Web Page option to search for the
desired file or web page.

After selecting the Existing File or Web Page option, you can then select the Current Folder, Browsed
Pages, or Recent Files option to help you search. If you choose the Current Folder option, you can select
and search a particular folder for the desired file or page. By default, the Look in list displays the web folder
for the site that is currently open. Some of the pages in the current web site may be listed twice. Open pages
appear at the top of the Current Folder list and all of the pages in the site appear in the bottom of the list box.
Selecting the Browsed Pages option displays a list of web pages you recently browsed. Selecting the Recent
Files option displays a list of files you recently used.

As you create links from the home page to various other pages in the current site, it is a good idea to create

links back to the home page from the other pages. These extra links allow the site visitor to return to the home
page quickly and easily from anywhere.
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You can also create links to other pages in a web by dragging a page from the Folder List to
the page on which you want the link to appear. The link will appear in colored text and
underlined. The text will reflect the page title, not the file name.

The Target Frame, Parameters, and Style options appear on the right side of the Insert
Hyperlink dialog box. These options represent more advanced settings for use with frame
pages, databases, and cascading style sheets.

Procedures
1. Open your website.

2. Open the web page containing the text or picture to which you want to add a hyperlink.

w

Select the text or picture you want to use to link to the desired page or file.

2

Under Link to:, select Existing File or Web Page.

Click the Insert Hyperlink button on the Standard toolbar.

Select Current Folder, Browsed Pages, or Recent Files option as desired.

Select the page or file to which you want to link.
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Select OK.

CREATING A LINK TO AN OUTSIDE WEBSITE

Discussion

You can easily create links to pages on the World Wide Web by entering the URLs (Uniform Resource
Locators) for the pages in the Insert Hyperlink dialog box. When you open the Insert Hyperlink dialog box, you
can choose the Existing File or Web Page option to display the Address text box. You can then type the
URL to which you want to link in this text box or navigate to the desired web page.

As you type a URL in the Address text box, the default protocol of http:// is entered automatically. If you want
to use another protocol, such as ftp, you can simply delete the existing text and enter the correct protocol and
Internet address.

If you do not know the address of the page to which you want to link, the Insert Hyperlink dialog box also
includes the Browse the Web button. This button allows you to open your browser and navigate to the web
resource to which you want to link. When you open the resource on the web and switch back to FrontPage
without closing the browser window, the correct protocol and address appear in the Address text box.

You can also create a link to an Internet resource by typing the URL on the web page in
Page view. When you type a URL and then press the [Enter] or [Spacebar] key, the text is
converted to a hyperlink.

The Target Frame, Parameters, and Style options appear on the right side of the Insert
Hyperlink dialog box. These options represent more advanced settings for use with frame
pages, databases, and cascading style sheets.
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Procedures

Open your website.

Open the web page containing the text or picture to which you want to link.
Select the text or picture you want to use to link to the desired page or file.
Click the Insert Hyperlink button on the Standard toolbar.

Under Link to:, select Existing File or Web Page.
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In the Address text box, type the URL of the website to which you want to link.

@

7. If you do not know the exact URL of the website you want to link to, click the Browse the

Web button.

This will open up Internet Explorer.

You can then search for or type in the site you want to link to.

Once you find the page you want to link to, do not close Internet Explorer. Simply return to

FrontPage (look for FrontPage at the bottom of your screen next to the Start button) and the
website address should be filled in for you.

7. Click OK.

CREATING A LINK TO A NEW WEB PAGE

Discussion

While you are editing web pages in Page view, you may want to add a link to a page you have not yet created.
When you create a link to a new page using the Insert Hyperlink dialog box, the new page is created and
added to your web site.

In the Insert Hyperlink dialog box, you can select the Create New Document option below Link to: to create a
link to a new document. You can then enter the file name of the document in the Name of new document text
box. If you need to change the path, which is the path for the current web by default, you can use the Change
button to change it. After typing the file name, you can choose to edit your new document immediately by
selecting the Edit the new document now option, which is the default setting. When you select this option,
the new page is created and opened for editing. You can also choose the Edit the new document later
option. When you select this option, the new page is created, but it is not opened for editing.

The Target Frame, Parameters, and Style options appear on the right side of the Insert
Hyperlink dialog box. These options represent more advanced settings for use with frame
pages, databases, and cascading style sheets.

Procedures

1. Open your website.
2. Open the web page containing the text or picture to which you want to link.

3. Select the text or picture you want to use to link to the new page.
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Right-click the selected text or picture.
Select the Hyperlink command.
Under Link to:, select the Create New Document option.

Type the name of the new document in the Name of new document text box.
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Under When to edit, click the Edit the new document later or Edit the new document now
option as desired.

9. Select OK.

CREATING A MAILTO LINK

Discussion

You can create a link that opens a site visitor's e-mail application and automatically addresses a message.
This type of link is useful when you want a visitor to be able to send you e-mail, such as feedback on your web
site.

In the Insert Hyperlink dialog box, you can use the E-mail Address icon below Link to: to create a link to an
e-mail address. To create the link, you simply type the e-mail address in the E-mail address text box and
FrontPage fills in the correct protocol, mailto:, automatically. You can also indicate the subject you want to
appear in these e-mail messages by completing the Subject text box. This feature is helpful as it allows you to
quickly navigate to messages sent using this link.

Instead of typing an e-mail address, you can select a recently used address from the Recently used e-mail
addresses list box. After you enter an address, it is added to this list. If you included a subject for an e-mail
link, the subject is stored along with the address in this list box.

The Parameters and Style options appear on the right side of the Insert Hyperlink dialog
box. These options represent more advanced settings for use with databases and cascading
style sheets.

Procedures

Open your website.

Open the web page containing the text or picture to which you want to link.
Select the text or picture you want to use to create a mailto link.

Select the Insert menu.

Select the Hyperlink command.

Under Link to:, select the E-mail Address icon.

Type the desired e-mail address.

Click in the Subject text box, if desired.
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Type the subject you want to appear in e-mails sent using this link.
10. Select OK.
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FOLLOWING A HYPERLINK

Discussion

As you create hyperlinks in web pages, you should check them to make sure that they link properly to the
desired pages, locations, and resources. In addition, you should create “return” links so that site visitors can
return back to the home page and/or the current page.

You can quickly “follow” a link from the Preview page in Page view or by previewing a page in your browser.
You can also follow links from the Normal page in Page view using a shortcut menu. Navigating within Page
view allows you to check the accuracy of your links without opening your browser to preview the site.

When you follow links to bookmarks from the Normal page, the linked information does not move up on the
page to be viewed in full as it does on the Preview page or in your browser. Instead, the linked information is
highlighted.

Typically, when a site visitor clicks a hyperlink, the linked text changes color to indicate that it has been visited.
This feature is helpful to visitors returning to a page as they can easily see which links they have selected
previously. When you follow a link from the Preview page in Page view or from your browser, it also changes
color.

To follow a hyperlink from the Normal page, right-click the hyperlink and select the Follow
Hyperlink command. You can also hold the [Ctrl] key and click the hyperlink to test it
from the Normal page.

In order for the Preview page to appear, you need Microsoft Internet Explorer installed on
your system. If the Preview page is not available, save the current page and then click the
Preview in Browser button on the Standard toolbar. You can then test a link in your
browser window.

Procedures
1. Open the page containing the link you want to test.
2. Click the Preview tab.

3. Click the desired hyperlink.

CHANGING HYPERLINK PROPERTIES

Discussion

If you find that a hyperlink is not working properly, you can edit the link using the Edit Hyperlink dialog box.
You can change the type of hyperlink or simply edit the URL or select a different page or file.

You can also type over a hyperlink to change the text displayed for the link, without removing the link itself.

You can remove a hyperlink by opening the Edit Hyperlink dialog box for the link and then
selecting the Remove Link button.

You can remove the underlining from hyperlinked text by selecting the text and then
clicking the Underline button the Standard toolbar to deselect it. While this feature can
be helpful to you in improving the appearance of your web site, visitors may not realized
the text is actually a link.
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Procedures

1. Open or switch to the page containing the link you want to edit.

2. Select the hyperlink you want to edit.

3. Click the Insert Hyperlink button
4. Edit the link as desired.
5. Select OK.

3

on the Standard toolbar.
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LESSON 6 -
USING GRAPHICS AND ANIMATIONS

WORKING WITH GRAPHICS AND ANIMATIONS

Discussion

Graphics and animations are an important element of a web page. At their most basic level, they can make a
web page more interesting and visually appealing to a visitor. They can help a web developer e2003ress an
idea or display items such as products to a potential audience. Graphics can also be used to provide an
alternate means of navigation.

You can add graphics with a variety of file formats including: .gif (standard and animated), .jpg (standard and
progressive), .bomp (Windows and OS/2), .png, .tif, .tga, .ras, .eps, .pcx, .pcd (Kodak Photo CD), and .wmf.
Typically, the .gif and .jpg formats are most often used for webs. While the .png format is also commonly
used, all browsers cannot display this file or require a plug-in to do so. Graphics can also be added from the
Microsoft Clip Organizer, the Internet, as well as from a scanner or camera.

GIF (.gif - Graphics Interchange Format) files can display a maximum of 256 colors and JPEG (.jpg - Joint
Photographics E2003ert Group) files can display millions of colors. While .qgif files cannot display as many
colors as .jpg files, they have an advantage over .jpg files in that one color, such as the background color, in a
.gif file can be made transparent, making it blend better with the page color scheme. The PNG (.png -
Portable Network Graphics) file format combines the color flexibility of the .jpg with the transparency of the
.gif. When you add a picture other than a .gif, .jpg, or .png, FrontPage automatically converts it into a .gif (for
256 colors or less) or a .jpg (more than 256 colors).

Once you add a picture to a page, the Pictures toolbar becomes available. You can use this toolbar to flip,
rotate, bevel, black and white, and wash out pictures. You can also change the brightness of pictures and add
text, as well as use the other formatting options to customize your pictures as desired.

In addition to static images, you can add animated .gif images to a web page.

Animated .gif files contain a series of images, which, when displayed in rapid succession, give an animated
effect. You insert animated .gif files like you would a static image file. The animation appears when you use
the Preview page to preview the page, or when you view the page in a browser that supports animation.

You can also use Dynamic HTML (DHTML) to apply special affects to your webs. Using DHTML, you can
control how page elements appear and what triggers the effect. For example, you can use DHTML to have
certain text spiral onto the page when the page loads. You can also apply effects to entire pages using page
transitions and hyperlink rollover effects. In addition, Dynamic HTML allows you to create collapsible outlines
on your web pages.

You can add video to your web pages as well. Any video file that can be played in Windows Media Player can
be added to a web page in FrontPage. Video can enhance your web pages by making them more visually
appealing and interesting to site visitors.

To add an image from a scanner or camera, select the Insert menu, point to the Picture
command, and then select the From Scanner or Camera command. You can then select
the device, resolution, and then select and insert the desired file.
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INSERTING A PICTURE FROM A FILE

Discussion

You can insert a variety of picture types into your web, with .gif and .jpg being the most common. Pictures add

interest to your pages and can be helpful in illustrating concepts or navigating your web.

You can acquire pictures from several sources using the Picture dialog box. You can use the Look in list to

navigate to image files stored in the current web or in another location to which you have access.

When you attempt to save a web page after adding a picture to it, you are prompted to save the picture to the
web site. Once you save the picture, it appears in the Folder List. You can then move it to the images folder to
keep all your pictures in one location, if desired. You can also save the picture file to the images folder or
another folder when you save it, using the Change Folder button in the Save Embedded Files dialog box.

You should always use the smallest possible file size for graphic images. This consideration will help to
minimize the amount of time required to transfer the web page from the server to the browser.

To place the picture files in your web into the images folder or another folder, switch to
Folders view and drag the picture files from the view pane to the desired folder in the Folder
List. To change the storage location when you save an image, select the Change Folder
button in the Save Embedded Files dialog box, and then navigate to and select the desired
folder.

You can view and modify the image properties by right-clicking the graphic and selecting the
Picture Properties command. You can use the Picture Properties dialog box to change the
size and positioning of an image, as well as view the image source and change the file type.

By default, graphics are saved to the web when you select OK in the Save Embedded Files
dialog box. If you want to link to the graphic file in its original location, you can select the Set
Action button and then select the Don’t Save option to create the link. Each time you save
the web page, however, the Save Embedded Files dialog box will open, prompting you to
save the file. Each time, you need to open the Set Action dialog box and select Don’t Save
in order to continue to link to the graphic.

Procedures

1. Open the desired page in Page view.

2. Position the insertion point where you want to insert the picture.

Click the Insert Picture From File button
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on the Standard toolbar.

Select the Look in list.

Select the drive containing the picture file you want to insert.
Select the folder containing the picture file you want to insert.
Select the picture file you want to insert.

Select Insert.

Save the web page and the embedded picture file.
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ADDING HOTSPOTS TO A PICTURE
Discussion

You can use pictures as links to other documents, pages, bookmarks, and Internet resources. The invisible
area on a picture, to which you have assigned a hyperlink, is called a hotspot. A picture with one or more
hotspots is called an image map. The practice of adding hotspots to pictures is also known as “image
mapping”. This process is often used to allow site visitors to click a picture, rather than a text link, to open a
related web page. An image map can contain numerous linked hotspots. You can use the Highlight Hotspots
button on the Pictures toolbar to view the hotspots contained in a picture.

Creating an image map involves designating different areas of a picture as hotspots. You can then link the
hotspots just as you would link text. Hotspots can be any shape or size; however, they should be large enough
for site visitors to locate and use. The Pictures toolbar provides shape buttons that control the shape of the
hotspot on a picture.

When dragging over the area of a picture that you want to designate as a hotspot, you should be careful not to
drag the border of the picture because you will move the entire picture. When a hotspot is created, the area
specified as the hotspot appears outlined on the Normal page in Page view. This outlined area is not visible to
a site visitor when the web page appears in the browser. Hotspots are identified just as other links are—the
mouse pointer changes into a hand when resting on a hotspot.

While you can create a hyperlink using a picture, hotspots allow you to create a link using only a portion of the
picture, instead of the entire graphic.

You can create a text hotspot by using the Text button on the Pictures toolbar to create
a text box on the page. Then, double-click the text box to open the Insert Hyperlink
dialog box and select the desired page or bookmark, create a new page, or enter the
URL or e-mail address to create the desired link.

You can edit hotspots in the Edit Hyperlink dialog box just as you would edit any other
hyperlink. To open this dialog box, right-click the hotspot, select the Picture Hotspot
Properties command, make the desired changes, and then select OK.

To reposition a hotspot area, click within the hotspot and drag it to the new location. To
resize a hotspot area, drag one of its sizing handles accordingly. Sizing handles are the
black squares that appear on the hotspot border.

Procedures

1. Open the desired page in Page view.

Select the picture to which you want to add a hotspot.

Click the Rectangular Hotspot or Circular Hotspot button on the Pictures toolbar.
Drag over the area of the picture you want to designate as a hotspot.

Under Link to:, select the appropriate option.
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Select the desired page or bookmark or enter the appropriate URL, new page name, or e-mail
address.

~

Continue to set the hotspot properties in the Insert Hyperlink dialog box, if applicable.
8. Select OK.
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USING THE INSERT CLIP ART TASK PANE
Discussion

One method of adding graphics to a web page is to use the Microsoft Clip Organizer, which contains
numerous images called clip art. The Clip Organizer contains hundreds of professionally designed illustrations
that can be freely incorporated into a web site. These illustrations include people, animals, landscapes,
banners, various types of equipment and tools, food, and an assortment of symbols. In addition to clip art, the
Clip Organizer contains many photographs, sounds, and video clips that can be used to enhance your web
pages. You can use the Insert Clip Art task pane to access the Clip Organizer.

To find a clip, enter a word related to the type of clip art you want to insert in the Search text box. Words used
in a search are called keywords. If you want to insert a clip on a web page, but you are not sure which one you
want to add, you can use a keyword search for clips. You can limit searches to a specific type of collection or
media file by selecting the corresponding option under the Other Search Options area. If you have changed
search criteria, but have not yet performed the search, you can use the Restore button to return to the
previous settings.

After entering your search criteria and selecting the Search button, thumbnails of the clip art found based on
the search criteria appear in the Results box. You can expand the Results box by clicking the button above
the first image. Clicking the button again returns the Results box to its previous size.

Pointing to a clip art image displays a ScreenTip with the keywords related to that image, its size in pixels, its
file size, and its graphic format. Clicking directly on a clip inserts it into your web. You can use the list of
options that appears when you right-click a clip or click its drop-down arrow to copy or delete the clip, edit the
clip keywords, find clips with a similar style, or view the clip properties.

If the list of found clips does not suit your needs, you can use the Modify button to modify the search or to
create a new one.

You can also find a graphic file by entering its file name in the Search text box in the
Insert Clip Art task pane. In addition, you can use wildcard characters [such as an
asterisk (*)] to find similarly named files. If you click the Search button with no text in the
Search text box, the Results box displays all available clips.

The Clip Organizer and Clips Online links in the Insert Clip Art task pane display
additional ways of searching for graphics, sounds, and animations.

Procedures

Open the desired page in Page view.

Position the insertion point where you want to insert the clip art image.

Select the Insert menu.

Point to the Picture command.

Select the Clip Art command.

If necessary, select Now in the Add Clips to Organizer message box to catalog the clips.
Select the Search text text box.

Type the desired keyword.
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To limit the search, click the Search in arrow.
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10.

11.
12.

13.
14.
15.
16.

17.
18.
19.

Click options as desired to select the collections you want to search or deselect the collections
you do not want to search.

Click the plus sign next to a collection to expand its contents.

Click options as desired to select the collections you want to search or deselect the collections
you do not want to search.

Press [Esc].
To limit what to search, click the Results should be arrow.
Click the plus sign next to any media type to expand its contents.

Click options as desired to select media you want to search or deselect media you do not want
to search.

Press [Esc].
Select the Search button.

Click any clip to insert it.
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LESSON 7 -
WORKING WITH TABLES

INSERTING A TABLE INTO A WEB PAGE

Discussion

You can use tables in web pages to organize text, graphics, and data. While tables are useful for creating
rows, columns, and cells for text and numbers, they also play an important role in page layout. Using tables,
you can control the positioning of objects (such as pictures and text) in relation to one another by placing
objects in cells within the tables. Unlike some other features, practically all browsers support tables; therefore,
you do not have to worry about your pages not appearing as intended or visitors receiving error messages.

There are several different ways to insert a table into a page. To insert a table quickly, you can use the Insert
Table button on the Standard toolbar. This method creates a table with the same number of cells in each row
and column. To create a table with irregular rows and columns, you can use the Draw Table command on the
Table menu to draw the rows and columns. To insert a table and set its properties, such as alignment, all at
once, you can use the Insert Table dialog box. If you use the Insert Table dialog box, you can set the
properties you select as the default properties for any new tables you create.

To assist you in working with tables, FrontPage has a Tables toolbar. This toolbar contains shortcuts for the
most common table tasks, such as inserting and deleting rows and columns, merging and splitting cells, and
changing the background color of a table. To use this toolbar, you first need to display and dock it. Once the
Tables toolbar is displayed, it remains displayed when you work inside a table, and is hidden automatically
when you work outside a table.

FrontPage 2003 has a new tables feature called “Layout Tables and Cells.” For more information on using
Layout Tables and Cells, see the “FrontPage 2003: Using Layout Tables” handout.

You can insert a table within a table by placing the insertion point in a table cell and then
using the Insert Table button to insert a table with the desired number of rows and columns.
This method is helpful when you need to customize your table layout.

To open the Insert Table dialog box, select the Table menu, point to the Insert command,
and then select the Table command. Select the desired table properties and if desired,
select the Set as default for new tables option to set the default properties for new tables.
Select OK to close the dialog box and insert the table.

Procedures

1. Open the page in which you want to add a table in Page view.

2. Position the insertion point where you want the table to appear.

[

3. Click and hold the Insert Table button on the Standard toolbar.

4. Drag to select the desired table size.

5. Save the web page.
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ADDING AND DELETING Rows OR COLUMNS

Discussion

You can add rows or columns to an existing table in Page view. There are two basic methods. If the Tables
toolbar is displayed, you can select one or more columns or rows and then use the Insert Columns or Insert
Rows button to insert the desired columns or rows. These buttons insert the selected number of columns or
rows to the left of the selected column or above the selected row. You can also use the Insert Rows or
Columns dialog box to add any number of rows or columns to an existing table. In addition, you can add the
new columns to either the left or right of the currently selected column. When inserting rows, you can add the
new rows above or below the selected row.

You can delete selected rows or columns from a table. If you delete rows or columns that contain objects such
as text or graphics, those objects are also deleted. You must select the rows or columns before you can delete

them.
To open the Insert Rows or Columns dialog box, select the Table menu, point to the
Insert command, and then select the Rows or Columns command.
| Drag to select multiple rows or columns before inserting additional rows or columns.
Procedures

1. Open the page containing the desired table in Page view.
2. Display the Tables toolbar.

3. Point to the left border of the row or the top border of the column where you want to insert a
new row or column.

4. Click to select the row or column.
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or the Insert Columns button

5. Click the Insert Rows button on the Tables

toolbar.

6. Point to the left border of the row or the top border of the column you want to delete.

7. Click to select the row or column.

&

8. Click the Delete Cells button on the Tables toolbar.

9. Save the web page.

ENTERING TEXT INTO A TABLE

Discussion

When you create a table, the insertion point appears in the first cell of the table by default, so that you can
immediately begin typing text into the table. Text is entered into a cell at the insertion point and is typed into a
cell just as it is typed into other areas of a web page. When the typed text exceeds the width of the cell,
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FrontPage automatically wraps the text to the next line. In addition, you can press the [Enter] key to create a
new paragraph within a cell.

You can format text in a table using the same features you use to format other text on a web page. You can
bold, italicize, and underline text in a table, as well as apply styles, change its color, and align it. The
underlining of text should not be used in order to keep the text from being confused with a hyperlink.

When you move existing text into a table using the Cut and
Copy features, the text is reformatted according to the table
default settings.

To navigate between cells in a table you can use the [Tab]
key, arrow keys, or the mouse. The [Tab] key advances you
to the next cell in the table, whereas the [Shift+Tab] key
combination will move the cursor to the previous cell in a
table.

Procedures
1. Open the page containing the desired table in Page view.
2. Position the insertion point in the cell in which you want to enter text.

3. Type the desired text.

MERGING CELLS IN A TABLE

Discussion

You can merge cells in a table to combine multiple cells into one cell. This feature is useful in controlling the
layout of text and other objects on a web page. You can use the Tables toolbar or the Table menu to quickly
merge the desired cells.

You can also merge cells by clicking the Eraser button on the
Tables toolbar and then dragging over the cell border
between the cells you want to merge. After merging the cells,
click the Eraser button again to deactivate it.

You can also merge cells by selecting the desired cells,
selecting the Table menu, and then selecting the Merge Cells
command.

Procedures

1. Open the page containing the desired table in Page view.
2. Display the Tables toolbar.

3. Select the cells you want to merge.
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4. Click the Merge Cells button E on the Tables toolbar.

SPLITTING CELLS

Discussion

You can split a cell into columns or rows. This feature is helpful in designing your page layout. You can use the
Tables toolbar or the Table menu to quickly split the cell into the desired number of columns or rows.

You can also split cells by selecting the Table menu and then
selecting the Split Cells command. In addition, you can use
the Draw Table button on the Tables toolbar to split cells into
uneven parts.

Procedures
1. Open the page containing the desired table in Page view.
2. Display the Tables toolbar.

3. Place the insertion point in the cell you want to split.

B

4. Click the Split Cells button on the Tables toolbar.

5. Select the Split into columns or Split into rows option.

6. Enter the number of columns or rows into which you want to split the
cell.

7. Select OK.

SPLITTING A TABLE

Discussion

You can split a table into multiple tables. This feature is helpful when you want to format parts of a table
differently. You can split the table and then format each table as desired. Splitting a table is also useful when
you need to insert text or other web page elements (pictures, etc.) in the middle of a table and do not want the
elements to be part of the table. You can quickly split a table using the Table menu.

Procedures

1. Open the page containing the desired table in Page view.
2. Click in the row that you want to be the first row in the second table.

3. Click the Table menu.
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4. Click the Split Table command.

ALIGNING TEXT VERTICALLY

Discussion

By default, text and objects are centered vertically within table cells. You can change the vertical alignment of
text and objects to the top or bottom of the cell. For example, if you want to create newspaper columns, you
can align the text to the top of the cell.

Procedures
1. Open the page containing the desired table in Page view.
2. Display the Tables toolbar.

3. Position the insertion point in the table cell in which you want to align
text.

4. Click the desired alignment button on the Tables toolbar.

ADJUSTING THE PROPERTIES OF A TABLE

Discussion

You can adjust table properties to control the appearance of a table in a web page. Using the Table Properties
dialog box, you can change the table layout, customize its borders, and apply a background color and/or
image.

The table layout includes the alignment of the table on the page, the cell padding (the space between the
content and cell borders), and the cell spacing (the space between cells in a table). It also includes the table
size, which can be specified in pixels or a percentage of the page. You can also specify how the text below the
table should flow around the table (float) or not flow around the table, which is the default setting.

The border settings include size and color, as well as the display of table and cell borders. You can increase
the border size to make the table border appear thicker on the page. You can also select a color for the entire
border, or choose colors for the lighter and darker areas of the table border. By default, only the table border
appears; however, you can choose to display the cell borders as well. Displaying the cell borders creates a
“double border” effect.

You can select a background color and/or image for a table. After applying a background color or selecting an
image, you should view your table to ensure that the cell contents can be seen clearly. You may need to
modify the text size and color settings.

If a table is within a frame, the table size percentage applies to
the size of the frame in which it appears; not the page.

You can also resize a table by dragging its borders.
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Procedures

Open the page containing the desired table in Page view.
Right-click any area of the table.

Select the Table Properties command.

Adjust the table settings as desired.

Select OK.
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Save the web page.

CHANGING THE PROPERTIES OF A CELL

Discussion

You can adjust the properties of an individual cell in a table. Using the Cell Properties dialog box, you can
change the cell layout, customize its borders, and apply a background color and/or image. Settings in the Cell
Properties dialog box can be applied to entire rows or columns as desired.

The layout options enable you to control the horizontal and vertical alignment of the cell contents, as well as
the size of the cell. When you size cells as a percentage, the cell size changes according to the size of the
table. When you size cells in pixels, the cell size remains constant regardless of the table size. If the Specify
width or Specify height option is not selected, the cell is sized according to its content. In the Cell Properties
dialog box, you can also specify how many rows or columns the cell spans, as well as control how web
browsers wrap the text in a cell. In addition, you can designate one or more cells as the header row in the
table, which results in the cell(s) being formatted differently.

You can select a color for the entire cell border, or choose colors for the lighter and darker areas of the cell
border. Depending upon the border settings for the table, you may not be able to see both the lighter and
darker cell border colors.

You can select a background color and/or image for a cell. After applying a background color or selecting an
image, you should view the cell to ensure that its contents can be seen clearly. You may need to modify the
text size and color settings.

| You can also resize cells by dragging the cell borders.

Procedures

Open the page containing the desired table in Page view.
Select the cell(s) you want to adjust.

Right-click the cell(s) you want to adjust.

Select the Cell Properties command.

Select the Specify width or Specify height option.

Select the current width or height, if applicable.
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Enter the desired width or height for the cell.

33



8. Select the In pixels or In percent option.
9. Continue to modify the cell properties as desired.

10. Select OK.
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